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Chapter 206

Superiority by a Margin
Tests for the Ratio of Two
Proportions
Introduction
This module computes power and sample size for hypothesis tests for superiority of the ratio of two independent
proportions. The non-offset case is available in another procedure. This procedure compares the power achieved
by each of several test statistics.
The power calculations assume that independent, random samples are drawn from two populations.

Technical Details
Suppose you have two populations from which dichotomous (binary) responses will be recorded. The probability
(or risk) of obtaining the event of interest in population 1 (the treatment group) is p1 and in population 2 (the
control group) is p2 . The corresponding failure proportions are given by q1 = 1 − p1 and q2 = 1 − p2 .
An assumption is made that the responses from each group follow a binomial distribution. This means that the
event probability, pi , is the same for all subjects within the group and that the response from one subject is
independent of that of any other subject.
Random samples of m and n individuals are obtained from these two populations. The data from these samples
can be displayed in a 2-by-2 contingency table as follows
Group
Treatment
Control
Total

Success
a
b
s

Failure
c
d
f

Total
m
n
N

The following alternative notation is sometimes used.
Group
Treatment
Control
Total

Success

Failure

Total

x11
x21
m1

x12
x22
m2

n1
n2
N

The binomial proportions, p1 and p2 , are estimated from these data using the formulae

p1 =

a x11
b x
=
and p 2 = = 21
m n1
n n2
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Comparing Two Proportions
When analyzing studies such as this, you usually want to compare the two binomial probabilities, p1 and p2 . The
most direct method of comparing these quantities is to calculate their difference or their ratio. If the binomial
probability is expressed in terms of odds rather than probability, another measure is the odds ratio.
Mathematically, these comparison parameters are

Parameter

Computation

Difference

δ = p1 − p2

Risk Ratio

φ = p1 / p2

Odds Ratio

ψ=

p1 / (1 − p1 ) p1q2
=
p2 / (1 − p2 ) p2q1

The choice of which of these measures is used might seem arbitrary, but it is not. Not only will the interpretation
be different, but, for small sample sizes, the powers of tests based on different parameters will be different. The
non-null case is commonly used in equivalence and non-inferiority testing.

Ratio
The (risk) ratio, φ = p1 / p2 , gives the relative change in the disease risk due to the application of the treatment.
This parameter is also direct and easy to interpret. To compare this with the difference, consider a treatment that
reduces the risk of disease from 0.1437 to 0.0793. One should consider which single number is more enlightening,
the fact that the absolute risk of disease has been decreased by 0.0644, or the fact that risk of disease in the
treatment group is only 55.18% of that in the control group. In many cases, the percentage (risk ratio)
communicates the impact of the treatment better than the absolute change.
Perhaps the biggest drawback to this parameter is that it cannot be calculated in one of the most common
experimental designs, the case-control study. Another drawback is that the odds ratio occurs directly in the
likelihood equations and as a parameter in logistic regression.

Hypothesis Tests
Although several statistical tests are available for testing the inequality of two proportions, only a few can be
generalized to the non-null case. No single test is the champion in every situation, so one should compare the
powers of the various tests to determine which to use.

Ratio
The (risk) ratio, φ = p1 / p2 , is often preferred as a comparison parameter because it expresses the difference as a
percentage rather than an amount. Three sets of statistical hypotheses can be formulated:
1.
2.
3.

H 0 : p1 / p2 = φ0 versus H1: p1 / p2 ≠ φ0 ; this is often called the two-tailed test.
H 0 : p1 / p2 ≤ φ0 versus H1: p1 / p2 > φ0 ; this is often called the upper-tailed test.
H 0 : p1 / p2 ≥ φ0 versus H1: p1 / p2 < φ0 ; this is often called the lower-tailed test.
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Power Calculation
The power for a test statistic that is based on the normal approximation can be computed exactly using two
binomial distributions. The following steps are taken to compute the power of such a test.
1. Find the critical value (or values in the case of a two-sided test) using the standard normal distribution. The
critical value, zcritical , is that value of z that leaves exactly the target value of alpha in the appropriate tail of
the normal distribution. For example, for an upper-tailed test with a target alpha of 0.05, the critical value is
1.645.
2. Compute the value of the test statistic, zt , for every combination of x11 and x21 . Note that x11 ranges from
0 to n1 , and x21 ranges from 0 to n2 . A small value (around 0.0001) can be added to the zero cell counts to
avoid numerical problems that occur when the cell value is zero.
3. If zt > zcritical , the combination is in the rejection region. Call all combinations of x11 and x21 that lead to a
rejection the set A.
4. Compute the power for given values of p1 and p2 as

n 
n 
1 − β = ∑  1  p1x11 q1n1 − x11  2  p2x 21 q2n2 − x 21
 x21 
A  x11 
5. Compute the actual value of alpha achieved by the design by substituting p2 for p1 to obtain

 n1   n2  x11 + x 21 n1 + n2 − x11 − x 21
q2
   p2
 x11   x21 

α* = ∑ 
A

Asymptotic Approximations
When the values of n1 and n2 are large (say over 200), these formulas often take a long time to evaluate. In this
case, a large sample approximation is used. The large sample approximation is made by replacing the values of
p1 and p 2 in the z values with the corresponding values of p1 and p2 under the alternative hypothesis and then
computing the results based on the normal distribution. Note that in large samples, the Farrington and Manning
statistic is substituted for the Gart and Nam statistic. Also, for large samples, the results for the odds ratio have not
(to our knowledge) been published. In this case, we substitute the calculations based on the ratio.

Test Statistics
Several test statistics have been proposed for testing whether the difference, ratio, or odds ratio are different from
a specified value. The main difference among the several test statistics is in the formula used to compute the
standard error used in the denominator. These tests are based on the following z-test

zt =

p1 − p 2 − δ0 − c
σ

The constant, c, represents a continuity correction that is applied in some cases. When the continuity correction is
not used, c is zero. In power calculations, the values of p1 and p 2 are not known. The corresponding values of
p1 and p2 under the alternative hypothesis are reasonable substitutes.
Following is a list of the test statistics available in PASS. The availability of several test statistics begs the
question of which test statistic you should use. The answer is simple: you should use the test statistic that you will
use to analyze your data. You may choose a method because it is a standard in your industry, because it seems to
have better statistical properties, or because your statistical package calculates it. Whatever your reasons for
selecting a certain test statistic, you should use the same test statistic during power or sample calculations.
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Miettinen and Nurminen’s Likelihood Score Test
Miettinen and Nurminen (1985) proposed a test statistic for testing whether the ratio is equal to a specified value,
φ0 . The regular MLE’s, p1 and p 2 , are used in the numerator of the score statistic while MLE’s ~p1 and ~p2 ,

p1 / ~
p2 = φ0 , are used in the denominator. A correction factor of N/(N-1) is applied to make
constrained so that ~
the variance estimate less biased. The significance level of the test statistic is based on the asymptotic normality
of the score statistic.
The formula for computing the test statistic is

z MNR =

p1 / p 2 − φ0
~~
~
p q~
N 
2 p q 

 1 1 + φ0 2 2  
n2   N − 1
 n1

where

~
p1 = ~
p2φ0
− B − B 2 − 4 AC
~
p2 =
2A

A = Nφ0
B = −[n1φ0 + x11 + n2 + x21φ0 ]
C = m1

Farrington and Manning’s Likelihood Score Test
Farrington and Manning (1990) proposed a test statistic for testing whether the ratio is equal to a specified value,
φ0 . The regular MLE’s, p1 and p 2 , are used in the numerator of the score statistic while MLE’s ~p1 and ~p2 ,
p1 / ~
p2 = φ0 , are used in the denominator. A correction factor of N/(N-1) is applied to
constrained so that ~
increase the variance estimate. The significance level of the test statistic is based on the asymptotic normality of
the score statistic.
The formula for computing the test statistic is

z FMR =

p 1 / p 2 − φ0
~~
~
p1q~1
2 p2 q2 
+
φ


0
n2 
 n1

p1 and ~
p2 , are computed as in the corresponding test of Miettinen and Nurminen (1985)
where the estimates, ~
given above.
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Gart and Nam’s Likelihood Score Test
Gart and Nam (1988), page 329, proposed a modification to the Farrington and Manning (1988) ratio test that
corrected for skewness. Let z FMR (φ ) stand for the Farrington and Manning ratio test statistic described above.
The skewness corrected test statistic, zGNR , is the appropriate solution to the quadratic equation
2
+ ( − 1) zGNR + ( z FMR (φ ) + ϕ~ ) = 0
(− ϕ~ ) zGNR

where

p2 ) 
p1 ) q~2 (q~2 − ~
1  q~1 (q~1 − ~
−

2 ~2
2 ~2
n2 p2 
n1 p1

ϕ~ = ~ 3/ 2 
6u 

q~1
q~
u~ = ~
+ ~2
n1 p1 n2 p2

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as the proportions, superiority and actual
ratios, sample sizes, alpha, and power.

Solve For
Solve For
This option specifies the parameter to be solved for using the other parameters. The parameters that may be
selected are Power, Sample Size, and Effect Size.
Select Power when you want to calculate the power of an experiment.
Select Sample Size when you want to calculate the sample size needed to achieve a given power and alpha level.

Power Calculation
Power Calculation Method
Select the method to be used to calculate power. When the sample sizes are reasonably large (i.e. greater than 50)
and the proportions are between 0.2 and 0.8 the two methods will give similar results. For smaller sample sizes
and more extreme proportions (less than 0.2 or greater than 0.8), the normal approximation is not as accurate so
the binomial calculations may be more appropriate.
The choices are
•

Binomial Enumeration
Power for each test is computed using binomial enumeration of all possible outcomes when N1 and N2 ≤
Maximum N1 or N2 for Binomial Enumeration (otherwise, the normal approximation is used). Binomial
enumeration of all outcomes is possible because of the discrete nature of the data.
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•

Normal Approximation
Approximate power for each test is computed using the normal approximation to the binomial distribution.

Actual alpha values are only computed when “Binomial Enumeration” is selected.

Power Calculation – Binomial Enumeration
Options
Only shown when Power Calculation Method = “Binomial Enumeration”
Maximum N1 or N2 for Binomial Enumeration
When both N1 and N2 are less than or equal to this amount, power calculations using the binomial distribution are
made. The value of the “Actual Alpha” is only calculated when binomial power calculations are made.
When either N1 or N2 is larger than this amount, the normal approximation to the binomial is used for power
calculations.
Zero Count Adjustment Method
Zero cell counts cause many calculation problems when enumerating binomial probabilities. To compensate for
this, a small value (called the “Zero Count Adjustment Value”) may be added either to all cells or to all cells with
zero counts. This option specifies which type of adjustment you want to use.
Adding a small value is controversial, but may be necessary. Some statisticians recommend adding 0.5 while
others recommend 0.25. We have found that adding values as small as 0.0001 seems to work well.
Zero Count Adjustment Value
Zero cell counts cause many calculation problems when enumerating binomial probabilities. To compensate for
this, a small value may be added either to all cells or to all zero cells. This is the amount that is added. We have
found that 0.0001 works well.
Be warned that the value of the ratio will be affected by the amount specified here!

Test
Alternative Hypothesis
This option specifies whether a one-sided or two-sided hypothesis is analyzed.
One-Sided (H1:R1<R0) refers to a one-sided test in which the alternative hypothesis is of the form H1: R1<R0.
One-Sided (H1:R1>R0) refers to a one-sided test in which the alternative hypothesis is of the form H1: R1>R0.
Two-Sided refers to a two-sided test in which the alternative hypothesis is of the type H1: R1≠R0. Here ‘≠’ means
unequal.
Note that the alternative hypothesis enters into power calculations by specifying the rejection region of the
hypothesis test. Its accuracy is critical.
Test Type
Specify which test statistic is used in searching and reporting.
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Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal proportions when in fact they are different.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. For this procedure, a type-I error occurs when you reject the null hypothesis of equal
proportions when in fact they are equal.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N1, solve for N2
Select this option when you wish to fix N1 at some value (or values), and then solve only for N2. Please note
that for some values of N1, there may not be a value of N2 that is large enough to obtain the desired power.

•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.
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N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1, solve for N2”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.
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•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.
You can enter a single value or a series of values.
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Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.

Effect Size – Ratios
R0 (Ratio|H0 = P1.0/P2)
This option specifies the ratio between the group 1 proportion under the null hypothesis P1.0 and P2. This ratio is
used with P2 to calculate the value of P1.0 using the formula: P1.0 = R0 x P2. The power calculations assume that
P1.0 is the value of the P1 under the null hypothesis. In this non-null case, the value of P1.0 is not equal to P2 as it
is in the null case.
You may enter a range of values such as 0.5 0.6 0.7 0.8 or 1.25 to 2.0 by 0.25. Ratios must greater than zero.
R1 (Ratio|H1 = P1.1/P2)
This option specifies the ratio of P1.1 and P2, where P1.1 is the proportion in group 1 under the alternative
hypothesis. This ratio is used with P2 to calculate the value of P1.1 using the formula: P1.1 = R1 x P2.The power
calculations assume that P1.1 is the actual value of the proportion in group 1 (experimental or treatment group).
You may enter a range of values such as 0.5 0.6 0.7 0.8 or 1.25 to 2.0 by 0.25. Ratios must greater than zero. They
cannot take on the value of one.

Effect Size – Group 2 (Reference)
P2 (Group 2 Proportion)
Specify the value of P2, the control, baseline, or standard group’s proportion. The null hypothesis is that the two
proportions differ by a specified amount. Since P2 is a proportion, these values must be between zero and one.
You may enter a range of values such as 0.1,0.2,0.3 or 0.1 to 0.9 by 0.1.
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Example 1 – Finding Power
A study is being designed to determine the effectiveness of a new treatment. The standard treatment has a success
rate of 65%. They would like to show that the success rate ratio of the new treatment to the old treatment is at
least 1.1.
The researchers plan to use the Farrington and Manning likelihood score test statistic to analyze the data that will
be (or has been) obtained. They want to study the power of the Farrington and Manning test at group sample sizes
ranging from 50 to 200 for detecting a ratio of 1.1 when the actual ratio ranges from 1.2 to 1.5. The significance
level will be 0.025.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for the Ratio of Two Proportions procedure window by
expanding Proportions, then Two Independent Proportions, then clicking on Superiority by a Margin, and
then clicking on Superiority by a Margin Tests for the Ratio of Two Proportions. You may then make the
appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example
Template.

Option

Value

Design Tab
Solve For ................................................ Power
Power Calculation Method ...................... Normal Approximation
Alternative Hypothesis ............................ One-Sided (H1: R1 > R0)
Test Type ................................................ Likelihood Score (Farr. & Mann.)
Alpha ....................................................... 0.025
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 50 100 150 200
R0 (Ratio|H0 = P1.0/P2) ......................... 1.1
R1 (Ratio|H1 = P1.1/P2) ......................... 1.2 1.3 1.4 1.5
P2 (Group 2 Proportion) ......................... 0.65

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Superiority Tests for the Ratio of Two Proportions
Test Statistic: Farrington & Manning Likelihood Score Test
H0: P1/P2 ≤ R0 vs. H1: P1/P2 = R1 > R0.
Power*
N1
0.10144
50
0.16144
100
0.22064
150
0.27900
200
0.30085
50
0.53006
100
0.70327
150
0.82128
200
(Report continues)

N2
50
100
150
200
50
100
150
200

N
100
200
300
400
100
200
300
400

Ref.
P2
0.6500
0.6500
0.6500
0.6500
0.6500
0.6500
0.6500
0.6500

P1|H0
P1.0
0.7150
0.7150
0.7150
0.7150
0.7150
0.7150
0.7150
0.7150

P1|H1 SM Ratio
P1.1
R0
0.7800
1.100
0.7800
1.100
0.7800
1.100
0.7800
1.100
0.8450
1.100
0.8450
1.100
0.8450
1.100
0.8450
1.100

Ratio
R1
1.200
1.200
1.200
1.200
1.300
1.300
1.300
1.300

Alpha
0.0250
0.0250
0.0250
0.0250
0.0250
0.0250
0.0250
0.0250

* Power was computed using the normal approximation method.
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Report Definitions
Power is the probability of rejecting a false null hypothesis.
N1 and N2 are the number of items sampled from each population.
N is the total sample size, N1 + N2.
P2 is the proportion for Group 2. This is the standard, reference, or control group.
P1 is the treatment or experimental group proportion. P1.0 is the smallest treatment-group response rate that
still yields a superiority conclusion. P1.1 is the proportion for Group 1 at which power and sample size
calculations are made.
SM R0 is the superiority ratio P1 / P2, assuming H0. R1 is the ratio P1 / P2 assumed for power and sample size
calculations.
Target Alpha is the input probability of rejecting a true null hypothesis. Actual Alpha is the value of alpha
that is actually achieved.
Summary Statements
Group sample sizes of 50 in Group 1 and 50 in Group 2 achieve 10.144% power to detect a ratio
in the group proportions of 1.200. The Group 2 proportion is 0.6500. The Group 1 proportion is
assumed to be 0.7150 under the null hypothesis and 0.7800 under the alternative hypothesis. The
test statistic used is the one-sided Score test (Farrington & Manning). The significance level
of the test is 0.0250.

This report shows the values of each of the parameters, one scenario per row.

Plots Section

The values from the table are displayed in the above charts. These charts give us a quick look at the sample size
that will be required for various values of R1.
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Example 2 – Finding the Sample Size
Continuing with the scenario given in Example 1, the researchers want to determine the sample size necessary for
each value of R1 to achieve a power of 0.80.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for the Ratio of Two Proportions procedure window by
expanding Proportions, then Two Independent Proportions, then clicking on Superiority by a Margin, and
then clicking on Superiority by a Margin Tests for the Ratio of Two Proportions. You may then make the
appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example
Template.

Option

Value

Design Tab
Solve For ................................................ Sample Size
Power Calculation Method ...................... Normal Approximation
Alternative Hypothesis ............................ One-Sided (H1: R1 > R0)
Test Type ................................................ Likelihood Score (Farr. & Mann.)
Power ...................................................... 0.80
Alpha ....................................................... 0.025
Group Allocation ..................................... Equal (N1 = N2)
R0 (Ratio|H0 = P1.0/P2) ......................... 1.1
R1 (Ratio|H1 = P1.1/P2) ......................... 1.2 1.3 1.4 1.5
P2 (Group 2 Proportion) ......................... 0.65

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Superiority Tests for the Ratio of Two Proportions
Test Statistic: Farrington & Manning Likelihood Score Test
H0: P1/P2 ≤ R0 vs. H1: P1/P2 = R1 > R0.
Target
Power
0.80
0.80
0.80
0.80

Actual
Power*
0.80013
0.80156
0.80020
0.80818

N1
831
190
74
35

N2
831
190
74
35

N
1662
380
148
70

Ref.
P2
0.6500
0.6500
0.6500
0.6500

P1|H0
P1.0
0.7150
0.7150
0.7150
0.7150

P1|H1 SM Ratio
P1.1
R0
0.7800
1.100
0.8450
1.100
0.9100
1.100
0.9750
1.100

Ratio
R1
1.200
1.300
1.400
1.500

Alpha
0.0250
0.0250
0.0250
0.0250

* Power was computed using the normal approximation method.

The required sample size will depend a great deal on the value of R1. Any effort spent determining an accurate
value for R1 will be worthwhile.
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Example 3 – Comparing the Power of the Three Test Statistics
Continuing with Example 2, the researchers want to determine which of the eight possible test statistics to adopt
by using the comparative reports and charts that PASS produces. They decide to compare the powers from
binomial enumeration and actual alphas for various sample sizes between 800 and 1000 when R1 is 1.2.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for the Ratio of Two Proportions procedure window by
expanding Proportions, then Two Independent Proportions, then clicking on Superiority by a Margin, and
then clicking on Superiority by a Margin Tests for the Ratio of Two Proportions. You may then make the
appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open Example
Template.

Option

Value

Design Tab
Solve For ................................................ Power
Power Calculation Method ...................... Binomial Enumeration
Max N1 or N2 for Binomial Enumeration 5000
Zero Count Adjustment Method .............. Add to zero cells only
Zero Count Adjustment Value ................ 0.0001
Alternative Hypothesis ............................ One-Sided (H1: R1 > R0)
Test Type ................................................ Likelihood Score (Farr. & Mann.)
Alpha ....................................................... 0.025
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 800 900 1000
R0 (Ratio|H0 = P1.0/P2) ......................... 1.1
R1 (Ratio|H1 = P1.1/P2) ......................... 1.2
P2 (Group 2 Proportion) ......................... 0.65
Reports Tab
Show Comparative Reports .................... Checked
Comparative Plots Tab
Show Comparative Plots ........................ Checked
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Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results and Plots
Power Comparison of Three Different Superiority Tests for the Ratio of Two Proportions
H0: P1/P2 ≤ R0 vs. H1: P1/P2 = R1 > R0.

N1/N2
800/800
900/900
1000/1000

P2
P1.1
0.6500 0.7800
0.6500 0.7800
0.6500 0.7800

Target
Alpha
0.0250
0.0250
0.0250

F.M.
Score
Power
0.7855
0.8311
0.8678

M.N.
Score
Power
0.7854
0.8311
0.8674

G.N.
Score
Power
0.7855
0.8305
0.8674

Note: Power was computed using binomial enumeration of all possible outcomes.
Actual Alpha Comparison of Three Different Superiority Tests for the Ratio of Two Proportions
H0: P1/P2 ≤ R0 vs. H1: P1/P2 = R1 > R0.

N1/N2
800/800
900/900
1000/1000

P2
P1.1
0.6500 0.7800
0.6500 0.7800
0.6500 0.7800

Target
Alpha
0.0250
0.0250
0.0250

F.M.
Score
Alpha
0.0250
0.0250
0.0251

M.N.
Score
Alpha
0.0250
0.0250
0.0250

G.N.
Score
Alpha
0.0250
0.0250
0.0251

Note: Actual alpha was computed using binomial enumeration of all possible outcomes.

All three test statistics have about the same power for all sample sizes studied.
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Example 4 – Comparing Power Calculation Methods
Continuing with Example 3, let’s see how the results compare if we were to use approximate power calculations
instead of power calculations based on binomial enumeration.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for the Ratio of Two Proportions procedure window by
expanding Proportions, then Two Independent Proportions, then clicking on Superiority by a Margin, and
then clicking on Superiority by a Margin Tests for the Ratio of Two Proportions. You may then make the
appropriate entries as listed below, or open Example 4 by going to the File menu and choosing Open Example
Template.
Option

Value

Design Tab
Solve For ................................................ Power
Power Calculation Method ...................... Normal Approximation
Alternative Hypothesis ............................ One-Sided (H1: R1 > R0)
Test Type ................................................ Likelihood Score (Farr. & Mann.)
Alpha ....................................................... 0.025
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 800 900 1000
R0 (Ratio|H0 = P1.0/P2) ......................... 1.1
R1 (Ratio|H1 = P1.1/P2) ......................... 1.2
P2 (Group 2 Proportion) ......................... 0.65
Reports Tab
Show Power Detail Report ..................... Checked

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results and Plots
Power Detail Report for Superiority Tests for the Ratio of Two Proportions
Test Statistic: Farrington & Manning Likelihood Score Test
H0: P1/P2 ≤ R0 vs. H1: P1/P2 = R1 > R0.
N1/N2
800/800
900/900
1000/1000

P2
0.6500
0.6500
0.6500

R0
1.100
1.100
1.100

R1
1.200
1.200
1.200

Normal Approximation
Power
Alpha
0.78503
0.0250
0.83049
0.0250
0.86734
0.0250

Binomial Enumeration
Power
Alpha
0.78552
0.0250
0.83109
0.0250
0.86783
0.0251

Notice that the approximate power values are very close to the binomial enumeration values for all sample sizes.
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Example 5 – Validation of Power Calculations using Blackwelder
(1993)
Blackwelder (1993), page 695, presents a table of power values for several scenarios using the risk ratio. The
second line of the table presents the results for the following scenario: P2 = 0.04, R0 = 0.3, R1=0.1,
N1=N2=1044, one-sided alpha = 0.05, and beta = 0.20. Using the Farrington and Manning likelihood-score test
statistic, he found the binomial enumeration power to be 0.812, the actual alpha to be 0.044, and, using the
asymptotic formula, the approximate power to be 0.794.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for the Ratio of Two Proportions procedure window by
expanding Proportions, then Two Independent Proportions, then clicking on Superiority by a Margin, and
then clicking on Superiority by a Margin Tests for the Ratio of Two Proportions. You may then make the
appropriate entries as listed below, or open Example 5(a or b) by going to the File menu and choosing Open
Example Template.

Option

Value

Design Tab
Solve For ................................................ Power
Power Calculation Method ...................... Binomial Enumeration
Max N1 or N2 for Binomial Enumeration 5000
Zero Count Adjustment Method .............. Add to zero cells only
Zero Count Adjustment Value ................ 0.0001
Alternative Hypothesis ............................ One-Sided (H1: R1 < R0)
Test Type ................................................ Likelihood Score (Farr. & Mann.)
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 1044
R0 (Ratio|H0 = P1.0/P2) ......................... 0.3
R1 (Ratio|H1 = P1.1/P2) ......................... 0.1
P2 (Group 2 Proportion) ......................... 0.04

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Superiority Tests for the Ratio of Two Proportions
Test Statistic: Farrington & Manning Likelihood Score Test
H0: P1/P2 ≥ R0 vs. H1: P1/P2 = R1 < R0.
Power*
0.81178

N1
1044

N2
1044

N
2088

Ref.
P2
0.0400

P1|H0
P1.0
0.0120

P1|H1 SM Ratio
P1.1
R0
0.0040
0.300

Ratio
R1
0.100

Target
Alpha
0.0500

Actual
Alpha*
0.0444

* Power and actual alpha were computed using binomial enumeration of all possible outcomes.

PASS calculated the power to be 0.81178 and the actual alpha to be 0.0444, which round to Blackwelder’s values.
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Next, to calculate the asymptotic power, we make the following changes to the template:
Option

Value

Power Calculation Method ...................... Normal Approximation

Numeric Results
Numeric Results for Superiority Tests for the Ratio of Two Proportions
Test Statistic: Farrington & Manning Likelihood Score Test
H0: P1/P2 ≥ R0 vs. H1: P1/P2 = R1 < R0.
Power*
0.79373

N1
1044

N2
1044

N
2088

Ref.
P2
0.0400

P1|H0
P1.0
0.0120

P1|H1 SM Ratio
P1.1
R0
0.0040
0.300

Ratio
R1
0.100

Alpha
0.0500

* Power was computed using the normal approximation method.

PASS also calculated the power to be 0.794.
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